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1 

Introduction 
 

Congratulations, you have purchased the ultimate in wireless home control technology – The Aegis 
Wireless Tablet (WWT).  The 1.9 lb Aegis Wireless Web Tablet features a rugged magnesium case, an 
8.4” TFT display and is powered by the Intel StrongARM processor providing “instant-on” capability 
with extended battery life.   
 
The Aegis Wireless Web Tablet uses the Windows CE.net operating system bringing with it numerous 
applications, including support for handwriting recognition, advanced thin client/server computing 
client software (RDP and ICA), Windows Media Player, local email client, dynamic display rotation, 
word processing and infra red control of most local media devices. This operating system is also 
compatible with many Windows 98, 2000 and XP functions including Microsoft Remote Desktop 
(commonly known as “mirror” technology).  Please note: like any Windows computer the WWT is 
subject to occasional “lock-ups”.  This situation is often brought on by running too many applications at 
once. 
 
 
Precautions 

• Do not apply excessive pressure to the display screen. 
• Avoid exposing the panel screen to direct sunlight or other heat source.  Where possible, the 

Aegis Wireless Web Tablet should be facing away from direct lighting to reduce glare. 
• DO NOT use any AC-DC adapter other than the one provided to power/recharge the unit. 
• In the unlikely event that, smoke, abnormal noise, or strange odor is present, immediately turn 

the Aegis Wireless Web Tablet off and report the problem to your device provider. 
• Never attempt to disassemble the Aegis Wireless Web Tablet - this will void the warranty.   

 
 
Package Contents 

• Aegis Wireless Web Tablet (Battery Pack built-in) with wireless LAN adapter 
• AC-DC Power Adapter – DO NOT use any other AC-DC adapter 
• Charging Cradle with USB slave port and IR keyboard interface 
• Power Cord (USA Type) 
• USB Cable 
• This document 
 
 

Before You Start, Charge the Battery 

 
Please charge the Aegis Wireless Web Tablet for at least six hours using the AC-DC adapter (directly 
or through the base) when setting up the device for the first time. The yellow charging light will turn 
green when the battery is fully charged.  Athough the Web tablet uses very little power in the suspend 
mode, it will fully discharge if left off of the charger for 48 hours or more.  If this occurs, the battery 
must be recharged and a warm reset may be necessary.  
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Web Tablet Layout  
 
 

 
 

 

 
 

• Button Functions 
 

Button Description Action 
1 Navigate/Scroll Left Push on left edge of oval button. 
2 Navigate/Scroll Right Push on right edge of oval button. 
3 Navigate/Scroll Up Push on upper edge of oval button. 
4 Navigate/Scroll Down Push on lower edge of oval button. 
5 Soft keyboard Toggle: Launch/Close Soft keyboard. 
6 Cradle I/F (USB and IR) 

Enable  
Enable IR keyboard and USB link with Cradle after 
device is secure on Cradle. 

7 Remote Desktop Connection Launch Remote Desktop Connection application. 
8 Desktop Minimize current application and return to Desktop. 
9 On/Off Quick Push enters or exits Suspend Mode. 
10 Record Button Push launches Recorder application or toggles between 

record and stop/pause functions. 
11 Reset Button (if device 

locks-up or will not start) 
Push and quickly release – device will restart 
automatically. 

 
 

1 2 

3 

4 

 5    6 7  8 

10 9 

Built-in Wireless  
802.11b Adapter IR Port Compact Flash 

Card Slot 

     Record (LED) 
Network 

Battery Internal Microphone 

Headphone Jack 

DC-In Jack 
(to AC/DC Adapter) 

11 

USB Port (Host) 
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Using the Cradle 
 
The Aegis Wireless Web Tablet uses a cradle for support, charging, communication with a PC and 
interaction with an optional IR keyboard.  Note: before using the cradle, the rubber protective cover 
must be removed from the center of the bottom edge of the web tablet.  On the cradle, you will find the 
following interfaces, a DC-in jack for the AC-DC adapter; a USB port, and a window for 
communication with the optional IR keyboard.  Please make sure that you seat the web tablet securely 
onto the cradle. 
 
 
          DC-in Port; IR Lens, and Cradle Connector 
 

                        
 

                                                                  USB Slave or Type B Port and Cradle Connector 
 

1. You may charge the battery pack on the Aegis WWT while it is in the cradle by connecting the AC-
DC adapter plugged into the DC-in port on the cradle.  

 
2. The Slave-type USB port on the cradle is used for connection between a desktop computer and the 

Aegis Wireless Web Tablet when the device docked on the Cradle.  This connection may be used 
for software installation, and software updating.  The ActiveSync software also leverages this 
connection for synchronization between a PC and the Aegis Wireless Web Tablet. 

 
NOTE:  The button with the “home” icon on the front bezel must be pressed to enable the USB 
Slave port (e.g., ActiveSync operation) and the IR keyboard operations on the Cradle.  Removing 
the WWT from this cradle or suspending the unit will cause the connection to be lost.  An “X” will 
re-appear across the Cradle Connection icon if the connection is lost or if the Aegis Wireless Web 
Tablet is not properly seated on the cradle.   
 

            
 

          Connection Established      Connection Not Established 
 
 
3. The Cradle is equipped with an IR lens and associated electronics to facilitate IR connection to a IR 

keyboard when the Aegis Wireless Web Tablet is securely docked on the Cradle. The matching 
(optional) keyboard is available from your equipment provider. 
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Suspend/Resume Button 
 
This is the recessed button along the left edge when facing the device.  Quick push of the button toggles 
between Suspend and Resume.  Please note that the WWT operating system cannot enter into Suspend 
mode again within 15 seconds after resuming.  Also note that holding the button will not engage 
Suspend/Resume – it will only temporarily dim the display. 
 
 
Battery and Power Management 
 
The Aegis Wireless Web Tablet is equipped with an internal Li-Ion battery pack that is capable of 
supporting approximately 3 hours of continuous operation.  The period between battery recharges can 
be significantly lengthened by putting the device into Suspend mode whenever the device is not in use.  
The Aegis Wireless Web Tablet may also be configured to automatically enter into power-saving 
modes after user-definable periods of device idle – see Start > Settings > Control Panel > Power 
Properties. 
 
A warning message will be generated during a low battery situation. If the Aegis WWT is not 
connected to the charger within a few minutes, it will automatically go into Suspend mode.  After the 
web tablet enters Suspend mode due to low battery condition: 
 

• The Suspend/Resume button will not resume the machine unless the AC-DC adapter is used.   
 
• If the system is left on for an extended period of time the battery power will may drain entirely.  

If after recharging the Web tablet will not start using the Suspend button you may have to reset 
the system (see below).  

 
 
Reset Button 
 
The reset button is recessed in a small hole at the back of the Aegis Web Tablet.  Use the stylus to 
operate this button.  Pushing the reset button briefly will generate a warm reset if the WWT locks-up.  
The effect is to clear the volatile memory (RAM) without affecting device settings.  This function is 
applicable to situations that include lockup of applications and preparation of device for software 
updates. If a warm reset doesn’t restart the WWT, try pressing and holding the reset button for four 
seconds and then simultaneously pressing the Suspend button for one second.  This “cold” reset will set 
the unit into default mode and your settings (including screen calibration) will have to be manually 
restored.   

 
Compact Flash Memory 
 

The Web Tablet has a slot on the upper right edge that will accept Compact Flash memory cards.  
These cards are the same ones used in many digital cameras and can expand the web tablet’s memory 
(by up to 64Mb).  Many Compact Flash cards from cameras can be inserted directly into the Aegis 
WWT to display family photographs, through the built-in document viewer program. 
 
Note: The label on the Compact Flash Card should face the back of the Web Tablet.  If the card doesn’t 
slide in easily, it may be backwards.
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Wireless Operation  
 
The Aegis Wireless Web Tablet features a PCMCIA slot that is used to support the pre-installed 
802.11b wireless LAN adapter. You must have an 802.11b base station, router or gateway with Internet 
connectivity to access the Internet with Aegis Wireless Web Tablet.  Some access points that have been 
successfully deployed with the Web Tablet include: Ambicom (WL1100B-AR) Cisco (Aironer 350) 
Dlink (DWL 1000AP, DI 713P, DI614+) Linksys (BEFW11S4, BEFW11P1) Netgear(MR314), SMC 
(SMC7004WBR, SMC7004AWBR, SMC2655W). 
 
Wireless Network Card and Antenna System 
 
The Aegis WWT is delivered with an embedded 802.11b card with a custom antenna in a snap-type 
housing.  The user has the choice of leaving the antenna in the snap-on position (A) or of pulling the 
antenna tip off the retainer snap and try to obtain better wireless connectivity through varying 
orientations up to near-vertical (B). 

        
 

(A)          (B) 
 
 
Setting up 802.11b wireless communication 
 
• Refer to the wireless base station operating manuals for setting up the 802.11b base station. 
 

• Click on the wireless LAN icon (see below) on the right side of the Windows Taskbar, to 
configure the wireless adapter. Once configured, it will connect automatically within 15 sec. 

 

                       or                
 

    Connection Established      Connection Lost 
        (Blinking icon indicates activity) 

 
 
NOTE:  You will not see any of the icons above in the Taskbar if the base station is not detected or 
supported by the Aegis Wireless Web Tablet. 
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For first connection, double click the wireless LAN icon.  A dialog box called PRISMNDS1 will 
appear.  Select the wireless information tab from this dialog box.  The Aegis Wireless Web Tablet will 
detect all 802.11b basestations in the vicinity.  Double Click the name of base station of your choice (it 
should turn reverse colors) and then click on the connect button.   
 
Connection to the 802.11b wireless network can take as long as 15 seconds.  If the signal strength is 
good, but the network will not associate, perform the following: Press the “advanced” button on the 
PRISMNDS1 wireless information dialog box.  Delete the “preferred networks” in the lower box.  Next 
select the available network you want from the top box and press the “configure” button.  
 
NOTE:   
 
The ESSID and WEP Parameter (if enabled) on the Aegis Wireless Web Tablet and the basestations 
have to match.  WEP is “Disabled” as default on the Aegis Wireless Web Tablet.  You may want to 
enable WEP encryption for more secure access. 
 

 
Start-Up 
 
To activate the Aegis Wireless Web Tablet, push and quickly release the Suspend button on the left 
side of the unit.  The display will come on after a delay of several seconds.  To turn the Aegis Wireless 
Web Tablet display off, push and quickly release the Suspend button.   
 
• If the power up is successful the Windows CE Desktop will be displayed after a launch sequence of 

several seconds. 
• The wireless LAN will take 10-15 seconds to (re)establish contact – look for the icon change. 
• Choose from any of the displayed icons on the Desktop to activate the corresponding application. 
 
Note: This document refers to “clicking” or “tapping” interchangeably.  The latter is applicable when 
the touch screen is utilized. 
 
 
 

Configuring the Web Tablet 
 
1. Click “Start” on the Windows CE Taskbar, select “Settings”, and then click on “Control Panel”. 
 
2. The Control Panel displays several icons associated with utilities for configuring the Aegis Wireless 

Web Tablet. Many of these are self-explanatory, however, some major ones are discussed below. 
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a) Display Quality/Properties set up (optional) 
i) Click on Display icon.  The Display Properties window will appear.  You can use choose to 

configure parameters associated with configuration of the display Background, Appearance 
and Backlight. 

 
ii) Click on Brightness icon to adjust the brightness of the display. 

 
 

b) Stylus Setup and Calibration (optional) 
i) Double-click Stylus; the Stylus Properties window will appear. 
ii) You can test Double-Tap function; you have to follow the instructions to double click the 

two squares right of the Window.  If it is correct, then click on OK at the top of the window 
for confirmation. 

iii) If you want to recalibrate or if your device is not responding properly to your stylus taps, 
select Calibration and follow the prompts to recalibrate.  When you are done, click on OK 
to continue. 

 
 

      c) Network Configuration (optional)  
This feature should only be used if you do not have success configuring the 802.11b connection 
through the icon on the task bar.  Double-click on Network and Dialup Connections icon.  
The displayed window will guide the configuration or provide information largely identical to 
accessing the Network icon displayed in the Taskbar when a supported network adapter is 
inserted and detected into the Aegis Wireless Web Tablet. 

 
In general, for an “Adapter” selected, click on Properties. 
iv) You have two options: Obtain an IP address via DHCP or Specify an IP address. 
v) When you select Obtain an IP address via DHCP, you are expecting that an IP address 

can be automatically assigned to this device.   
vi) When you select Specify an IP address; you have to ask your network administrator for an 

address and type it in the space provided (IP Address, Subnet Mask, and Default Gateway).  
In addition to that you have to specify additional WINS or DNS in Name Servers, then 
click on “OK” at the top of the window for confirmation. 

 
c) System Properties Set Up (optional) 

Click on System; the System Properties window will appear. 
i) Click on General, the System information will be displayed.  Then click on OK at the top 

of the window for confirmation. 
ii) Click on Memory, you can adjust the allocation of unused RAM to run programs or for 

storage (by moving the arrow to right or left).  After changes, click on OK at the top of the 
window for confirmation. 

iii) Click on Device Name, you can provide a unique name to the device as identification for 
network resource access such as file sharing, etc.  

iv) For additional applications, Compact Flash memory may be obtained at most computer 
stores and installed in the upper right slot in the web tablet. 
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Infrared Remote Control Configuration 
 
 

The WWT Infrared control has a database of built-in codes, but is also capable of learning codes from 
those devices that are not in the database. Like any learning remote the Aegis WWT is capable of 
learning most IR codes, but may not be able to learn IR schemes outside of “normal” parameters.   
 
Double Click the pyramid shaped Universal Remote Icon (MUSE) on the Desktop to activate the 
remote. The first time you use this application you should configure this application for the particular 
audio/video components that you own.  On the top bar of the remote control application select Options 
> Device Setup.  On the device set-up screen select the type of device that you would like to control 
(i.e., TV-1, DVD, etc.).  Next, select the manufacturer of your equipment and device profile #1.  Close 
the screen with the “X” in the upper right corner to go back to the universal remote screen where you 
can test the IR functions.  If they do not work, you should go back to Device Setup set-up to choose 
another device profile number. 

 
Once you have assigned the appropriate components and codes activating the button for a particular 
source on the IR control screen will bring up a virtual keyboard appropriate for that source component. 
Just tap on the appropriate button to issue the IR command.  The hardware cursor control button (on the 
right side of the screen) can also be assigned to remote functions like volume and channel selection. 
 
IR Learning 
 
If you do not find the appropriate device/profile code, the Aegis Web Tablet is capable of learning most 
codes.  In order to do this, go to the main control screen and select Tools > Sample.  Select a Device 
Type from the pull down menu at the top.  Next you should use the stylus to tap the Mfg. Name Field.  
Type in the manufacturer using the virtual keyboard (activate by pressing the left mechanical button on 
the front).  Next, tap Description Field and type in the description (both fields must be filled in).  
Remove the virtual keyboard by pressing the (mechanical) keyboard button again – Do not press enter.   
 
Next Select Start.  Hold the handheld remote facing IR Window on the front of the Web Tablet, 6-12 
inches from the window.  Press the Sample Now button. The prompt in the box will tell you which key 
on the handheld remote to press (it typically starts with the numeric keys and then prompts Play, Stop, 
Volume, etc.).  Press and hold the key for one full second.  The Aegis WWT will prompt you to press 
the key at least one more time.   Next the WWT will prompt you to learn the next key.  When all of the 
keys have been either learned or skipped, the device will prompt you to Save the Profile. 
 
After saving the profile, the main screen will appear.  Go to Options > Device Setup and double tap 
appropriate device type.  Go to the “Custom Profile” pull down menu and select the device that you just 
learned.  Tap the select button and then close the window using the “X” in the top right corner.  You 
will see the device displayed in the appropriate place on the device setup screen.  Close that screen with 
the “X” on the upper right corner.  Select the device and test the codes.  If any don’t work, go back and 
relearn.  When you are finished configuring the IR codes go to Start > Settings > Control Panel > 
Registries.  Follow the prompts to save the registry that will save the IR codes in case the Web Tablet 
has to be rebooted.  Saving the registry does not show progress and will take approximately 30 seconds.  
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Internet Explorer 
 
When you want to surf the web, click on Internet Explorer on the Desktop screen – the Aegis 
Wireless Web Tablet will display the default web site (for example, www.aegishome.com).  You can 
change the default web site by using IE browser, View in menu bar, and select Internet Options. 
 
If you want to leave the Internet to go to Windows CE desktop yet you want to keep the web browser 
open, just “minimize” the browser window using the rightmost icon button on the task bar or the 
rightmost button on the face of the WWT’s magnesium enclosure.  You can click on the Windows 
CE.net Taskbar any time to return to maximize any application. 
 
The IE browser in CE.net is based on the Internet Explorer 5.5 engine. You may wish to examine 
and manipulate your browser configuration options through Internet Explorer > View > Internet 
Options to optimize your experience. 
 
 
Reading and Sending E-mail 
 
Users of AOL should access their e-mail via AOL.com.  Users of other ISP’s may choose to use the 
local email client (Inbox) instead of a web-based email solution. 
 
Inbox Configuration (optional) 
 
i) Open Inbox program. 
ii) Go to Services tab, select Options.  After you click on Options you will see in a new 

window five tabs, which are:  Services, Compose, Read, Delete and Storage. 
iii) Select Services, click Add, choose which type of email service do you have, IMAP or 

POP3, and select one. 
iv) In the Setup Mail definition (IMAP or POP3) you must provide the information required 

Connection, Server, User ID, and Password.  If you don’t have these information contact 
your Network Administrator. Click Next. 

v) In this window you will configure the Connections Settings.  There are several options – 
use the default values and click Next. 

vi) The last window is the Mail Inbox Preferences.  Select the options more suitable to your 
needs – you either need to get the full copy messages or you want the headers only. 

 
NOTE:  Files in .TXT, .DOC, .DOT, .RTF, HTML, .GIF and .JPG formats may be read. 
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Other Built-in Applications 
 
Document Viewers 
 
These programs allow you to view common various types of photographs as well Microsoft documents 
such as Word documents, Excel spreadsheets and PowerPoint shows.  You may access the 
document viewers by tapping on the appropriate icon on the desktop.   
 
Once a document viewer is open select the file menu to view the file that you want. If you want to 
access a file on another computer on the network enter \\ and then the network name of the computer in 
the box that says name at the bottom of the Open dialog box.  For viewing outside of the range of the 
network, you could also “copy” the file from another computer on the network and “paste” this file into 
the “My Documents” folder on the WWT.  Please note that the memory available in My Documents is 
quite limited. 
 
 
Viewing Family Photos 
 
A great way to view family photographs is to create a PowerPoint presentation on your main PC and 
then play it as a slide show your Aegis Web Tablet. Select the presentation from your remote PC via 
the network or copy the presentation to the “My Documents”.  Open the PowerPoint Viewer and 
select Slide Show > View Show.  If you want the pictures to continuously cycle you can select Slide 
Show > Set Up Show and select the automatically advance radio button and check “loop 
continuously”. 
 
 
Transcriber 
 
This is the versatile handwriting recognition application provided with the CE.net operating system.  
Transcriber may be activated by double tapping on icon on the CE.net Desktop or by selecting Start > 
Programs > Transcriber.  So that mouse taps do not get confused with handwriting entries, it is 
advised that you start your Application (e.g., WordPad) before activating Transcriber.  A Help menu is 
available for guidance with the Transcriber application. 
 
 
Terminal Clients: ICA and RDP  

 
You may use web tablet to connect to Citrix and Microsoft Terminal Servers. 

i) “Start” > “Programs” > “Terminal Client” > “Citrix ICA” OR activate Desktop icon 
(Citrix ICA) to connect to a Citrix Terminal Server. 

ii) Activate “Remote Desktop Connection” from the Desktop to connect to a Microsoft 
Terminal Server (or to a PC running Microsoft Windows XP Pro). 
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Word Processing 
 
Aegis WWT provides the WordPad word processing application.   

 
Inking 

 
Write messages or take notes using the touch screen for records or for transmittal via e-mail as 
attachments.   

 
Screen Rotation 

 
The Aegis Wireless Web Tablet offers software for the dynamic rotation of the display between 
landscape and portrait modes.  The display may be selected to be oriented 90, 180 or 270 deg. 
relative to the default landscape mode.  The mode change will be effected immediately, without 
need for re-start of the device.  Screen rotation may not fully apply to applications that are 
already open. 
 

 
Voice Recorder 
 

A voice recorder will be activated if the Record button is pushed.  Pushing the button again will 
stop or pause the recording action.  Subsequent pushes toggle between record and stop.  The 
application may only be closed manually. 
 

Windows Remote Desktop  
 

Any Windows XP Pro computer can be operated remotely through the Aegis Wireless Web Tablet.  
This tremendously powerful feature allows the Aegis WWT to remotely execute and display any 
application that resides on the “host” PC.   While the application is actually executed within the remote 
PC, it is controlled and displayed by the Wireless Web Tablet. 
 
In order to use the Remote Desktop function the remote XP Pro PC must be connected to the 
wireless network configured to accept remote activation.  On the XP Pro PC select Start>Control 
Panel>System, then select the Remote tab at the top. On the remote page check “Allow users to 
connect remotely to this computer”. Next select “Remote user” and verify that the appropriate user 
name is present in the box at the top.  Remote desktop requires that the remote computer must have 
both a user name and a password to work.  If passwords are not assigned, go to Start>Control 
Panel>User Accounts.  Double click on the appropriate account and assign a password according to 
the prompts. 
 
To activate the Remote Desktop function from the Aegis WWT, press the third button under the 
WWT screen (the one with the computer icon).  Activate the virtual keyboard with the leftmost button 
under the screen, and type in the name of the computer you want to control.  When finished click on the 
connect button.  The name of the computer should appear on the top of the screen as well as a prompt 
for the User Name and Password.   Enter both items using the virtual keyboard, and click “Okay”.  You 
should observe the desktop of the remote computer.  If you receive an authorization error, verify that 
the remote computer has a password assigned to it and that the password is valid. 
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Software Synchronization (optional) 
 
The Aegis Wireless Web Tablet is amenable to software installation, development and synchronization 
through connection to a host PC where the primary software resides.  This is enabled by a USB cable-
based connection between the host PC and the USB Slave port on the cradle of the Aegis Wireless Web 
Tablet.  The following steps should be taken only by people familiar with PC applications: 
 

i) Install ActiveSync 3.1 or 3.5 on host PC. 
http://www.microsoft.com/mobile/pocketpc/downloads/activesync35.asp 

ii) Install USB driver for Aegis Wireless Web Tablet on host PC (obtain as required from your 
device provider). 

iii) Securely seat the Aegis Wireless Web Tablet on the Cradle. 
iv) Connect USB cable between Aegis Wireless Web Tablet’s Cradle and host PC. 
v) Enable the USB connection by engaging the appropriate (#6, per Buttons Function Table) 

button on the Aegis Wireless Web Tablet.  Verify that the Cradle Connection icon is active. 
vi) Use the ActiveSync application to select and initiate the files/software transfer. 

 
NOTE:  Suspend/Resume or removing Aegis Wireless Web Tablet from cradle turns off the connection 
between Aegis Wireless Web Tablet and host PC.  The Cradle Enable button (#6) needs to be used 
again to re-establish the connection.  Always refer to the Cradle Connection icon on the Windows CE 
Taskbar for verification. 
 
 
 
Device Registry (optional) 
 
The device registry characterizes the device, defining supported device components and peripherals, 
applications and content.  Many registry elements are being changed or updated during a typical session 
of operation.   
 
At key events such as low battery level or upon adding favorites in the browser, registry contents will 
be saved from volatile memory to flash ROM automatically, ensuring persistence of the registry 
settings, even after total power loss.  A typical save process will take about 4 seconds.  The Registries 
Saving utility in Windows CE Control Panel can be used to manually save registry contents to ROM as 
well. 
 
 
Right Mouse Function 
 
Right-mouse function has been added to the Windows CE Taskbar.  Select the mouse icon on Taskbar 
to enter Right-mouse mode.  The system will automatically switch back to Left-mouse mode after 
single use in Right-mouse mode or by selecting the mouse icon again on the Taskbar. 
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Upgrading Applications via the Internet 
 
From time to time software applications like the IR remote control feature may be upgraded with newer 
versions.  Your equipment supplier will let you know when an upgrade is available and give you the 
appropriate website address and the name of the file to download. 
 
In order to upgrade an application, go to the Start > Settings > Control Panel > Upgrade.  Choose 
The FTP tab and using the virtual keyboard, enter the address given you by your equipment supplier 
and tap the connect button.  A box should appear that lists the files that you can download.  Choose the 
appropriate file and press select.  Follow the screen prompts to complete the installation. 
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Frequently Asked Questions 
 

General 
 
Is the Windows CE.net operating system on the Web Tablet the same as Pocket PC? No, Pocket 
PC is a custom version of Windows CE developed by Microsoft. The Pocket PC operating system and 
applications were designed specifically for PDAs. 
 
How do you enter information on the Web Tablet? The Web Tablet has a virtual touch screen 
keyboard to enter information with the stylus; to activate the keyboard, press on the soft keyboard 
button on the front left side under the screen. To deactivate the keyboard, press on the soft keyboard 
button again. The cradle also allows use of an optional wireless keyboard.  
 
How can I protect my information from unauthorized access? The Web Tablet comes with a 
security utility that allows you to set your password. When password authentication is enabled, you 
need password entry to modify or execute owner information, firmware update, system settings, reset to 
factory default configuration and password changes. Activate the password icon within the control 
panel to initiate the password protection functions.  
 
Can I install third party software on the Web Tablet? No. The Web Tablet is not designed to 
facilitate user installation of third party software.  
 
Can I print from the Web Tablet? Yes, the Web Tablet can print to printers connected directly (USB) 
or to networked and shared printers. The Web Tablet current supports the Cannon C60 and Epson 
Stylus 777 for direct printing from the Tablet through USB. Use File > Print function for direct 
printing. To share or network printers from the tablet: 1) Join the tablet to the domain of your network 
by entering a valid username and password and domain name in the network icon on the identification 
tab in the Control Panel. 2) Go to communication icon in Control Panel and change the device name 
to something other than the default name of “wince”. 3) In IE choose print then under port choose 
network, then enter path to the printer \\serverName\ PrinterShareName. 4) The printer must be 
shared off of a computer on the network for this to work.  
 
What does the scroll key do? Scroll through Web pages and change level settings, such as Volume 
and Brightness, when the cursor is placed in the vicinity of the respective control or indicator bar.  
 
Can the Web Tablet perform these functions? Play MP3 audio? YES, Windows Media Player plays 
MP3s. Run Java applets? YES, the Java Virtual Machine (JVM) in the Web Tablet facilitates this. 
Access Macromedia Flash-based web sites? YES, the Web Tablet features a Flash Player. View files of 
various formats? YES, PDF and Office document, such as Word, Excel, and PowerPoint. Print? YES, 
you may print to selected local (USB) and networked or shared printers. Download MP3 files? NO. 
View Real Player streaming media? NO.  
  
Can I expand my storage memory? The web tablet has a Compact Flash (CF) card slot that is enabled 
to allow users to insert a CF memory card to expand the available memory storage.  
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Software  

  
Can I update the Web Tablet? The Web Tablet is equipped with a utility that can update the 
operating system (including applications, etc.) and BIOS. The update utility enables Aegis Systems to 
provide fixes to deployed devices.  
 
Can I save files in the Web Tablet? Yes, you can save files to the My Documents folder.   Permanent 
files must be saved to the optional Flash Storage folder and its subfolders. If you save files to other 
folders, you will lose them if the Web Tablet depletes its battery to a full power-off state.  
 
What are the capabilities of the Java Virtual Machine? The Web Tablet features Insignia's Jeode 
platform. Jeode has been certified and is fully compliant with Sun's Personal Java 1.2 and Embedded 
Java 1.0.3 specifications, which is roughly equivalent to JDK version 1.1.8. For a complete description 
of the JVM, refer to Insignia's web site.  
  
   
Communication  

What is the communication method for the Web Tablet? The Web Tablet comes with a built-in 
wireless RF Networking Module, which is compatible 802.11b routers and bridges (also known as 
Access Points).  It uses spread spectrum technology in the 2.4 GHz (unlicensed) frequency band. The 
data transfer rate ranges from 1, 2, 5.5 to 11 Mbps. Actual wireless link performance varies depending 
on the environment and the number of simultaneous users.  
 
What is 802.11b wireless technology? The 802.11b wireless LAN systems use radios in the 2.4-GHz 
frequency band - the same band used by microwave ovens. The advantages of this band are that it 
provides a lot of spectrum space and does not require licensing of the radio devices. Recognizing the 
critical need to support higher data-transmission rates, the Institute of Electrical and Electronics 
Engineers (IEEE) 802 committee ratified the 802.11b standard in September 1999 for transmissions of 
up to 11 Mbps. These radio-based standards operate within the 2.4 GHz ISM band. These frequency 
bands are recognized by international regulatory agencies, such as the FCC (USA), ETSI (Europe), and 
the MKK (Japan)for unlicensed radio operations.  
 
What is an 802.11b Access Point? The 802.11b standard defines two types of equipment, a wireless 
station or client (may be a PC or an Internet Appliance such as the Web tablet that is equipped with a 
802.11b radio or wireless network interface card) and an access point (AP), which acts as a bridge 
between the wireless and wired networks. The access point acts as the base station for the wireless 
network, aggregating access for multiple wireless stations onto the wired network. Access points may 
also include functions such as Dynamic Host Control Protocol (DHCP), Network Address Translation 
(NAT), PPPOE registration, and Firewall functions.  
 
Can I use any 802.11b access points or routers with the Web Tablet? Yes. The 802.11b standard 
facilitates this flexibility. To ensure that security of the wireless link can be achieved, ESSID and WEP 
support has to be provided by these access points and routers. Access points that have been certified to 
work with the Web Tablet are the following: Ambicom (WL1100B-AR) Cisco (Aironer 350) Dlink 
(DWL 1000AP, DI 713P, DI614+) Linksys (BEFW11S4, BEFW11P1) Netgear(MR314), SMC 
(SMC7004WBR, SMC7004AWBR, SMC2655W)  
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What is the data rate of 802.11b RF technology? To support very noisy environments as well as 
extended range, 802.11b WLANs use dynamic rate shifting, allowing data rates to be automatically 
adjusted to compensate for the changing nature of the radio channel. Ideally, users connect at the full 11 
Mbps rate. However when devices move beyond the optimal range for 11 Mbps operation, or if 
substantial interference is present, 802.11b devices will transmit at lower speeds, falling back to 5.5, 2, 
and 1 Mbps. Likewise, if the device moves back within the range of a higher-speed transmission, the 
connection will automatically speed up again. Rate shifting is a physical-layer mechanism transparent 
to the user and the upper layers of the protocol stack.  
 
What if I have more than one Web Tablet or other 802.11b clients? The number of 802.11b clients 
"allowed" is dependant on the capabilities of your access point. Many access points allow up to 256 
simultaneous connections. However, as on any network, performance degrades as traffic increases. It is 
possible to add additional in-range 802.11b access points to share the traffic load. Consult the 
documentation provided with your access point to understand its capabilities. 
 
How do I configure a static (manual) IP address the Web Tablet? To configure a static IP address 
on the Web Tablet click Start > settings > control panel > network. Select the adapter to you are 
using and click the properties button. Next click the Specify an IP address radio button and enter in the 
IP address, subnet mask and default gateway. It may also be necessary to input the DNS servers on the 
name server tab. 
 
Can I use a USB-based communication device with the Web Tablet? No. The Web Tablet is 
currently designed only for use over the built-in wireless RF LAN for communications.  
 
Is the wireless link secure? The wireless link used by the Web Tablet is based on the IEEE 802.11b 
wireless technology. Security is a common concern among potential WLAN users. 802.11b specifies 64 
bit or 128-bit encryption via wired equivalent privacy (WEP), an optional security mechanism designed 
to make wireless link integrity equal to that of wired links. Note that WEP is optional, which means 
some products might not use it. If you're concerned about the security of your wireless data, be sure to 
choose access points and client adapters that support WEP.  
 
How do I configure security on the Web Tablet? To configure, double tap the Wireless LAN utility 
in the system task tray (The small round icon with a lightning bolt). On the configuration tab make sure 
that the SSID matches the base station OS SSID (sometimes referred to as a network name) also on the 
Encryption tab make sure that encryption is enabled to match the base station at 64 bit or 128 bit and 
the keys match. After any changes are made to the card you must click ok then restart the Web Tablet.  
 
 
What is Roaming? When an 802.11b client such as the Web Tablet is in an environment with two or 
more access points are in-range the client is responsible for choosing the most appropriate access point 
based on the signal strength, network utilization and other factors. When a station determines the 
existing signal is poor, it begins scanning for another access point. The station selects the most 
appropriate signal and sends an association request to the new access point. If the new access point 
sends an association response, the client has successfully roamed to a new access point. Periodically the 
802.11b client surveys all 802.11b channels in order to assess whether a different access point would 
provide it with better performance characteristics. If it determines that this is the case, it re-associates 
with the new access point, tuning to the radio channel to which that access point is set.  
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Communication continued…. 
 
Is 802.11b RF technology safe? As with other wireless technologies, WLANs must meet stringent 
government and industry standards for safety. There have been concerns raised across a number of 
wireless technology industries regarding the health risks of wireless use. To date, scientific studies have 
been unable to attribute adverse health effects to WLAN transmissions. In addition, the output power of 
wireless LAN systems is limited by FCC regulations to under 100 mW, much less than that of a mobile 
phone.  
 
Other than WEP, what other security features are available? ESSID (often called SSID) For the 
access control, the ESSID (also known as a WLAN Service Area ID) is programmed into each access 
point and is required knowledge in order for a wireless client to associate with an access point. An 
identification value called ESSID is programmed into each access point to identify which subnet it is 
on. This can be used as an authentication check; if a station does not know this value, it is not allowed 
to associate with the access point. Normal LAN Security 802.11b RF networks support the same 
security standards supported by other 802 LANs for access control (such as network operating system 
logins) and encryption (such as IPSec or application-level encryption). These higher-layer technologies 
can be used to create end-to-end secure networks encompassing both wired LAN and WLAN 
components, with the wireless piece of the network gaining unique additional security from the 802.11 
feature set.  
  
  

Power Management 

  
What is the standard battery life on the Web Tablet? The battery life for the Web Tablet can be up 
to approximately four hours under typical usage. Note that actual results can vary with individual 
usage.  
 
How long does it take to charge and recharge the battery? It can take up to 3 hours to fully charge 
the battery.  
 
Can I use the Web Tablet while charging under AC power? Yes. It will not interfere with the 
charging process.  
 
 
How can I maximize battery life? To extend the life of the battery, you can: Set the brightness to the 
lowest comfortable brightness setting Set the Sleep and Power Off timers to the lowest comfortable 
time Set the speaker volume to the lowest comfortable setting Use the AC-DC adapter and charging 
cradle as often as possible.  
 
Am I able to use different kinds of batteries to power the Web Tablet? No. The Web Tablet is 
designed only for use with lithium-ion battery packs specially designed for the unit.  
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Will I lose critical information, stored in the system, if the battery pack runs out of energy? Yes, 
If the battery is completely drained the unit will have to be reset using the recessed reset button on the 
back of the web tablet.  The reset process will set the web tablet to the original factory defaults.  The 
most obvious thing that might happen is that the Aegis logo may disappear from the desktop.  This may 
be avoided if the web tablet is left on the charger when not in use. 
 
 

Warranty 
 
Six months – parts and labor.  Shipping costs are not included.  This warranty does not cover the 
battery, broken touch screen glass, damaged touch membranes, or other mechanical damage.  
 
 

Technical Support 
 
For consumers, technical support is provided by the company that provided the web tablet.  Installing 
dealers may obtain technical support from Aegis Systems 800-263-4641, www.Aegishome.com. 
  
 


